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PREFACE 
The Ziauddin University Examination Board (ZUEB) was established under Sindh ACT XLI 2018, 

with the primary objective of enhancing the quality of education in Sindh. ZUEB is responsible for 

administering examinations for the Secondary School Certificate (SSC) and Higher Secondary 

School Certificate (HSSC) in alignment with the most recent revisions to the National Curriculum, 

as outlined by the Directorate of Curriculum Assessment and Research (DCAR), Sindh. Through 

its ordinance, ZUEB is mandated to provide examination services for both English, Urdu, and Sindhi 

medium candidates from private schools across Sindh. This examination syllabus reflects ZUEB’s 

dedication to achieving the educational goals set by the provincial authorities. 

In collaboration with subject professors, ZUEB has developed a comprehensive syllabus for each 

subject. It is important to distinguish between the syllabus and the curriculum. The syllabus serves as 

a guide for both teachers and students, outlining the key areas of focus within the subject. It provides 

students with a clear understanding of what is expected of them in their studies and helps them prepare 

effectively for their exams. 

This examination syllabus incorporates all cognitive outcomes derived from the Provincial 

Curriculum Statement, ensuring that assessments are both valid and reliable. While the focus is 

primarily on the cognitive domain, significant emphasis is placed on the application of knowledge and 

understanding. 

The syllabus is made available to all stakeholders via the ZUEB website to assist affiliated schools in 

planning their teaching. It is crucial to note that the syllabus, rather than the prescribed textbook, forms 

the foundation of ZUEB examinations. Additionally, this syllabus supports the development of learning 

materials for both students and teachers. ZUEB remains committed to supporting students undertaking 

the SSC and HSSC courses by facilitating their learning outcomes through this detailed syllabus 

document. 

To further assist in the learning process, ZUEB provides a dedicated e-resource tab on its website, 

offering both text-based and video content on various subjects. These 15-20 minute instructional 

videos, created around key subject concepts, allow students to learn at their own pace and convenience. 

The videos can be used as a reinforcement tool to revisit lessons already taught or as pre-lesson 

material. This initiative is an ongoing effort, and new videos will continue to be uploaded. 

We encourage all students and educators to make the most of these resources for a more enriched and 

flexible learning experience. 

Sincerely, 
Shahbaz Nasim 

Head – Measurement & Testing 

Ziauddin University Examination Board 

 
Reviewed by: 

Sana Anwer Ali 

Manager Sciences 

Ziauddin University Examination Board 

July 2025 
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       Rationale For The Reviewed Provincial Curriculum 

The process of revising the National Curriculum 2006 began in August 2004, when the newly elected 

government of Pakistan initiated education reforms across the country. These reforms included the 

introduction of a new National Education Policy, a National Education Census, and a revision of 

curricula (Ministry of Education, 2009). 

In practice, the overhaul of the secondary school curriculum began in 2006, leading to a review of the 

scheme of studies for classes I to XII and the revision of curricula for 25 compulsory subjects. 

 

The 18th Amendment to the Constitution of Pakistan, enacted in 2010, significantly altered the 

federal- provincial relationship by abolishing the "concurrent legislative list." This amendment 

granted provinces greater legislative and financial autonomy in sectors such as education and health. 

The most notable implication of the 18th Amendment for education was the transfer of responsibility 

for curriculum development, syllabus planning, policy formation, and educational standards to the 

provinces, marking a significant step forward for education. 

In Sindh, the School Education Department tasked a Curriculum Review Team with revising the 

National Curriculum 2006 for all subjects. The goal was to create a curriculum better suited to the 

needs of students and teachers while aligning with the principles of the 18th Amendment. Subject- 

specific curriculum review committees were established to critically examine and align the 

curriculum's content, both contextually and textually, ensuring coherence across various subjects. The 

Bureau of Curriculum (BoC) played a crucial role in organizing workshops and meetings in Hyderabad 

to facilitate the completion of this task. The support of numerous educationists, researchers, and 

teachers was invaluable in successfully revising the curriculum. 

The Ziauddin University Examination Board (ZUEB) SSC and HSSC syllabi are developed in 

accordance with the Sindh Revised Curriculum. To date, textbooks for various subjects have been 

developed based on the revised curriculum. 
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UNIT 1: BASIC CONCEPTS OF INFORMATION TECHNOLOGY 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

1.1 Introduction 

to 

Computer 

System 

 Identify computing devices used for input, process, storage 
and output; 

 Describe simple data processing cycle (input, process, 
output and storage); 

 Classify computers according to processing speed, size 
and uses (microcomputer, minicomputer, mainframe 
computer and supercomputer); 

 * 
 

* 

* 

 

1.2 Computer 

Hardware 

and their 

examples 

 Differentiate between manual data entry and automatic 
data capture devices;

 Describe the function of manual data entry devices and 
their uses in daily life, i.e. keyboard, scanners (2D and 3D), 
microphone, pointing devices (graphics tablet, joystick, light 
pen, mouse, touchpad, trackball), digital camera, interactive 
whiteboard and touch screens (capacitive, resistive and 
infrared);

 Compare the types of automatic data capture devices and 
their uses in daily life, i.e. magnetic card reader (MCR), 
magnetic ink character reader (MICR), optical character 
reader (OCR), barcode reader, optical mark reader (OMR) 
and quick response (QR) code reader;

 * 

* 
 

 

 

 

 

* 

 

1.3 Computer 

Software 

 Differentiate among application software, system software 
and internet applications;

 Describe the types of system software i.e. operating 
system, programming language translators, utility software 
and device driver;

 Describe the use of different application software and their 
types;

 Compare licensed software, open source software, 
shareware and freeware with examples;

 * 
 

* 

 

* 
 

* 

 

1.4 Computer 
Memory 

 Describe important characteristics of memory devices; 

 Convert digital storage units from one to another, i.e. bit, 
nibble, byte, kilobyte (KB), kibibyte (KiB), Megabyte (MB), 
Mebibyte (MiB), Gigabyte (GB), Gibibyte (GiB), Terabyte 

 * 
* 

ZIAUDDIN UNIVERSITY EXAMINATION BOARD    

SLOs CATEGORIZATION 

XI - COMPUTER SCIENCE 
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  (TB), Tebibyte (TiB), Petabyte (PB) and Pebibyte (PiB); 

 Differentiate between primary (main) memory and 
secondary memory;

 Differentiate among Random Access Memory (RAM), Read 
Only Memory (ROM) and internal processor memory;

 Compare the two types of RAM, i.e. Static RAM (SRAM) 
and Dynamic RAM (DRAM);

 Compare three types of ROM, i.e. Programmable ROM 
(PROM), Erasable Programmable ROM (EPROM) and 
Electrically Erasable Programmable ROM (EEPROM);

 Describe the role of Basic Input/ Output System (BIOS) in 
boot-up process;
Compare the three types of cache memory, i.e. Level-1 
(L1) cache, Level-2 ( L2 ) cache and Level-3 (L3) cache; 

 Compare magnetic, optical and solid state storage devices;

 Describe magnetic storage and its types, i.e. magnetic 
tapes and disks;

 Describe various types of optical storage media, i.e. 

Compact Discs (CDs), Digital Versatile Discs (DVDs) and 

Blu-Ray;

 Identify CDs and DVDs as CD-ROM, CD-R, CD-RW, DVD- 

ROM, DVD-R, DVD-RW and DVD-RAM;

 Describe solid state storage devices (flash memory and 
Secure Digital (SD) cards);

 Differentiate between sequential and direct access storage.

 

* 

* 
 

* 
 

* 
 

 

* 
 

 

* 
 

* 
 

* 

* 
 

* 

* 

 

1.5 Inside 

System Unit 

 Differentiate between CPU and system unit; 

 Discuss the role of three major components of system unit, 
i.e. casing, power supply and motherboard; 

 Differentiate among different types of ports, i.e. serial port, 
parallel port, PS/2 port, Universal Serial Bus (USB) port, 
fire wire port and High Definition Multimedia Interface 
(HDMI) port; 

 Compare the six types of expansion cards, i.e. sound card, 
video graphics card, modem card, Network Interface Card 
(NIC), gigabit card and wireless network card; 

 Differentiate between two categories of memory modules, 

i.e. Single Inline Memory Module (SIMM) and Dual Inline 
Memory Module (DIMM). 

 * 
* 

 

* 

 

 

* 

 

\ 

* 

 

 

UNIT 2: INFORMATION NETWORKS 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

2.1 Introduction 
to Computer 
Networks 

 Define a computer network; 

 Differentiate among different types of networks depending 
upon coverage area and use: 
a. nano network 

* 
* 
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  b. Body Area Network (BAN) 
c. Personal Area Network (PAN) 
d. Near-me-Area Network (NAN) 

e. Local Area Network (LAN) 
f. Wide Area Network (WAN) 
g. Metropolitan Area Network (MAN) 
h. Internet Area Network (IAN) 
i. Interplanetary Internet (IPN); 

 Compare the types of network topologies, (i.e. star, ring, 
bus, mesh and tree) with the help of diagrams; 

  

 

 

 

 

 

 

* 

 

2.2 LAN Models  Explain Client/Server Model and Peer-to-Peer (P2P) Model  *  

2.3 World Wide 

Web 
 Where the internet started 

o from ARPANET to World Wide Web 

o Internet 

o The Global Village 

o Who Governs the internet 

o Connecting to the internet 

*   

2.4 Internet 

Abuse 
 Differentiate between 

o Cybercrime 

o Cyberbullying 

o Spamming 

o Malware 

 *  

 

UNIT 3: DATA COMMUNICATIONS 
 

S. 

no. 

Content and 

Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

3.1 Introduction to 
Data 
Communication 

 Describe basic network components, i.e. sender, 
message, medium, protocol, receiver; 

 Discuss the role of the four data communication devices, 
i.e. hub, switch, router and gateway; 

 Differentiate between guided and unguided media and 
their types, i.e. 
a) guided media (telephone cable, twisted pair cable, 

coaxial cable and fibre optic cable) 
b) unguided media (microwave transmission and satellite 

communication); 

 Compare three modes of data transmission, i.e. simplex, 
half-duplex and full-duplex; 

 Differentiate between two types of transmission, i.e. serial 
and parallel; 

 Differentiate between synchronous and asynchronous 
transmission of data; 

 * 
 

* 

 

  
* 

   

 

* 

  
* 

  
* 
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3.2 OSI Model  Differentiate among seven layers of Open System 
Interconnection (OSI) model;

 Identify protocols and devices used on every layer of OSI 

model;

 * 
 

 

* 

 

3.3 TCP/ IP 

Protocol 

Architecture 

 Define Transmission Control Protocol/ Internet Protocol (TCP/ 
IP) architecture; 

 Describe function of each layer of TCP/ IP protocol architecture; 

 Compare the TCP/ IP model with the OSI model; 

 Differentiate between circuits switching and packet switching 
with examples; 

 Differentiate between Internet Protocol version 4 (IPv4) and 
Internet Protocol version (IPv6); 

 Identify the class of an IPv4 address on the basis of IP range. 

* 
 

* 
* 

 

   
* 

   
* 

   
* 

3.4 Short Distance 

Wireless 

Communication 

 Compare the types of short distance wireless technologies, i.e. 

Wireless Fidelity (Wi-Fi), Worldwide Interoperability for 
Microwave Access (WiMAX), Bluetooth and Infra-red; 

 *  

3.5 Long Distance 

Wireless 

Communication 

 Explain mobile (cellular) communication; 

 Describe the role of components required for mobile 

communication (mobile phone, base station, switching node, 

landline telephone network); 

 Describe the limitations of mobile communication systems; 

 Explain Global Positioning System (GPS); 

 Differentiate among Geostationary Earth Orbit (GEO) satellites, 
Medium Earth Orbit (MEO) satellites and Low Earth Orbit 
(LEO) satellites; 

 Define the following wireless protocols: 

a. Wireless Application Protocol (WAP) 

b. Wired Equivalent Privacy (WEP) protocol. 

 * 
* 

 

   
* 
* 

* 

  
 

* 

 

 

UNIT 4: APPLICATIONS AND USE OF COMPUTERS 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

4.1 Uses of 

Computers in 

Various fields 

 Study the various ways computers are being used in Information 

Management, Personal Productivity, Communication, Research, 

Science, Engineering, Education, Entertainment, Art, Business, 

Agriculture, Government, Health, Medicine, Robotics etc. 

 *  

4.2 Positive 

Impacts of 

Computers 

 How computers are making a positive impact on people’s lives, 
health, environment, future etc. 

 *  

4.3 Negative  How computers are impacting human life and their surrounding  *  
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 Impacts of 

Computes 

with new mental problems, creating brainwashed robots, how 

governments are using computers to control people, their way of 

live, and thinking. 

   

 

UNIT 5: COMPUTER ARCHITECTURE 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

5.1 Components 

of Central 

Processing 

Unit (CPU) 

 Describe the role of CPU in computer system; 

 Describe functions of components of CPU, i.e. Arithmetic and 

Logic Unit (ALU), Control Unit (CU), registers, cache, internal 

buses (data bus, address bus and control bus) with the help of a 

block diagram; 

 Describe the functions of following registers and their types, i.e. 

a. general purpose register (Accumulator (AC) and Data 

Register (DR), Base Register (BR), Counter Register 

(CR)) 

b. special purpose register (Instruction Register (IR), Memory 
Address Register (MAR), Program Counter (PC), Memory 
Buffer Register (MBR)); 

 * 

 

* 

 

 

 

* 

 

5.2 Various 

Operations 

Performed 

by CPU 

 Compare three types of instructions of CPU, i.e. data transfer 
instructions, data processing instructions and program control 
instructions; 

 Compare different types of CPU instruction formats, i.e. zero 

address instruction, one address instruction and two address 
instruction; 

 Describe fetch – decode – execute cycle with the help of a 
diagram; 

 Differentiate between Complex Instruction Set Computer 
(CISC) and Reduced Instruction Set Computer (RISC) 
architecture; 

 Differentiate between Intel P4 and advanced micro devices 

(AMD) Athlon on the basis of clock speed, bus width, cache and 
architecture. 

 * 

 

 

* 

 

 

* 

 

 

* 

 

* 

 

 

UNIT 6: SECURITY, COPYRIGHT AND THE LAW 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

6.1 Computer 
Crimes 

 Classify between computer crimes like 

o Software Piracy 

o Theft of Hardware 
o Cyberterrorism 

 *  
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  o Theft of time and service 

o Hacking 
o Denial of Service Attack 

   

6.2 Computer 

Viruses 
 Differentiate between different computer viruses and malwares 

o Worm 

o Trojan Horse 

o Ransomware 

o Spyware 

o Adware 

o Scareware 
o Boot sector 

 *  

6.3 Preventive 

Measures 

against 

Viruses 

 Learn how one user can protect his/her computer from different 

computer crimes and viruses through 

o Antivirus software 

o Identifying and Authenticating Users 

o User Names and Passwords 

o Possessed Objects 

o Biometric Devices 

o Firewalls, Encryption, and Audits 

o Making Backups 

 *  

 

UNIT 7: WINDOWS OPERATING SYSTEM 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

7.1 Introduction 

to Operating 

System 

 Identify the commonly used operating systems; 

 List the tasks performed by an operating system; 

 Differentiate between command line interface and graphical 

user interface of an operating system; 

 Differentiate between single user operating system and multi 
user operating system; 

 Compare the types of operating system, i.e: 

a. simple batch system 

b. multiprogramming batch system 

c. multitasking operating system 

d. distributed operating system 

e. real-time operating system 

f. parallel processing operating system 

g. multiprocessor operating system 

h. embedded operating system 

i. time-sharing operating system; 

 

* 

* 

 

* 

* 

 

 

* 

 

7.2 Functions of 

Operating 

System 

 Describe the main functions of operating system, i.e. process 

management, memory management, file management, I/ O 

system management, secondary storage management, 

protection system, interrupt handling, network management, 

command-interpreter; 

 *  
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7.3 Process 

Management 
 Determine the sequence of execution of processes to get the 

minimum execution time; 

 Explain the process state diagram including new, running, 

waiting/ blocked, ready and terminated states of a process; 

 Differentiate between thread and process; 

 Differentiate among multithreading, multitasking, 
multiprogramming and multiprocessing. 

  

 

* 

 

* 

* 

* 

7.4 Working 
with GUI OS 

• Familiarize with environment of the Windows Operating System 

• Apply data management techniques (files/ folders) 

o Creation 

o Deletion 

o Copying 

o Renaming 

• Understand the concept drives and paths 

• Apply files and folders searching options 

• Understand the Properties and Attributes of files and folders 
• Demonstrate the management of the hardware software 
resources through control panel 

• Use DirectX (dxdiag) command to analyze the computer resources 

• Show and Change System Configurations by using msconfig. 

  

 

 

 

 

 

* 

* 

* 

 

 

* 

* 

* 

* 

 

 

 

 

 

 

 

 

* 

 

UNIT 8: WORD PROCESSING 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

8.1 Editing 

Documents 

 Create, Edit, Delete, Format, Enhance, Print .docx files in 

MS Word 

 *  

8.2 Basic 

Word 

Processing 
Functions 

 Learn and apply basic word functions like page layout, design, 

Document review, creating PDFs, inserting pictures to 

documents etc. 

  * 

8.3 Word 

Processing 

Software 

 Learn to work with and install different word processing 

software like Corel WordPerfect, OpenOffice Writer, Microsoft 

Word, WPS etc. 

  * 

 

UNIT 9: SPREADSHEET SOFTWARE 
 

S. 

no. 

Content 

and Scope Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

9.1 Working 

with Rows 

and Columns 

in Excel 

 Learn to work in rows and columns i.e to edit them merge, 

delete, insert, move, color it, label them, selecting ranges, 

changing width and heights of columns, Alignment, Graphing, 

and additional spreadsheet features. 

 *  
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9.2 Data types in 

Spreadsheet 

software 

 Learn about the data types in spreadsheets like numbers, 

addition, subtraction, multiplication, division, comparison 

operators, handling blanks, empty strings, zero values, text, 

logical, error, implicit and explicit data type conversion in 

DAX formulas etc. 

 *  

9.3 Working 

with 

Formulas 

 Learn to use formulas of SUM, AVERAGE, COUNT, 

SUBTOTAL, MODULUS, POWER, CEILING, FLOOR, 

CONCATENATE, LEN, REPLACE, SUBSTITUTE, LEFT, 

RIGHT, MID, NOW(), TODAY() etc. 

 *  

9.4 Popular 

Spreadsheet 

Software 

 Learn to work with and install different spreadsheet software 

like MS Excel, Google Sheets, WPS Office, OpenOffice 

Calc, Smartsheet, LibreOffice etc. 

  * 

 

UNIT 10: INTERNET BROWSING AND USING EMAIL 
 

S. 

no. 

Content 

and 

Scope 

Learning Outcomes/Skills 
Cognitive 

Level 

  Students will be able to: K U A 

10.1 Browsing the 

Web 

 Use the web browsing i.e Google chrome, Mozilla 

Firefox, Microsoft Edge etc and use it to search on 

internet. 

  * 

10.2 Downloading 

Files 

 Download music files, pictures, software etc different types of 

downloadable files from the internet. 

 *  

10.3 Understanding 

Email 
 Use emailing website like outlook, gmail, mailchimp etc.   * 
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GRADE 11 COMPUTER SCIENCE 

PBA Sample Questions 

 

Q.1. A student uses a scanner to digitize a painting, then saves it on a hard drive. Which stage is scanning and 

which stage is saving? 

 
a) Input, Processing b) Input, Storage 
c) Processing, Storage d) Storage, Output 

 
Answer: b 

 
Q.2. A bank ATM uses: 
 

1. A card reader to get account data, 
2. A receipt printer to give a transaction summary. 

Identify input and output device. 
 

a) Card Reader = Input, Receipt Printer = 
Output 

b) Card Reader = Output, Receipt Printer = 
Input 

c) Both are Input d) Both are Output 

Answer: a 

Q.3. A researcher needs a computer system that can: 

1. Perform real-time weather simulations, and 

2. Handle billions of data points simultaneously. 
Which system fits? 

 
a) Minicomputer b) Microcomputer 
c) Mainframe d) Supercomputer 

Answer: d 

Q.4. A school result system requires: 

1. Fast data processing, 
2. High volume storage. 

Which type of system is best? 

 
a) Minicomputer b) Supercomputer 
c) Mainframe d) Microcomputer 

Answer: c 
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Q.5. In a supermarket: 

1. Customer’s product is scanned at checkout. 
2. The price is read directly from the barcode. 

Which devices are used? 

 
a) OCR and MICR b) Barcode Reader and OMR 
c) Barcode Reader and Database d) QR Reader and OCR 

Answer: c 

Q.6. A teacher distributes multiple-choice answer sheets where students fill bubbles. Which device: 

1. Captures these answers? 
2. Category? 

 
a) OCR, Input b) OMR, Input 
c) QR Reader, Output d) Barcode Reader, Storage 

Answer: b 

Q.7. A hospital uses: 
1. MRI scan images, 
2. A microphone for doctor’s notes. 

Which is automatic and which is manual entry? 

 
a) MRI = Manual, Mic = Automatic b) MRI = Automatic, Mic = Manual 
c) Both Manual d) Both Automatic 

Answer: b 
 
Q.8. A student downloads a “free game” that secretly installs software to steal passwords. 

1. Which Internet abuse is this? 

2. Which preventive measure should be used? 

 
a) Cyberbullying & Spam filter b) Cybercrime & Antivirus 
c) Spamming & Firewall d) Malware & Antivirus 

 
Answer: d 

 
Q.9. A walkie-talkie system allows communication in both directions but not at the same time. 

1. Which mode is this? 

2. Which device is a real-life example of full-duplex? 

 
a) Half-duplex & Mobile phone b) Full-duplex & Walkie-talkie 
c) Simplex & Mobile phone d) Duplex & TV remote 

 
Answer: a 
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Q.10. Satellite communication is used in remote areas. 

1. What type of waves are used? 

2. Which disadvantage is most common? 

 
a) Radio waves & High speed b) Microwaves & Delay/Latency 
c) Infrared & Low bandwidth d) Microwaves & Unlimited coverage 

 
Answer: b 

 
Q.11. A video conference is lagging due to low bandwidth. 

1. Which factor of data transmission is directly affected? 

2. Which solution improves it? 

 
a) Delay & More storage b) Bandwidth & Faster connection 
c) Error rate & Antivirus d) Propagation time & Backup 

 
Answer: b 

 
Q.12. In multitasking OS, two programs run together. 

1. Which OS feature makes this possible? 

2. Which resource is divided among processes? 

 
a) Time-sharing & CPU b) Multiprocessing & RAM 
c) Device management & Cache d) Scheduling & Disk 

 
Answer: a 

 
Q.13. Utility software helps maintain systems. 

1. Which utility detects and removes malware? 

2. Which utility improves file access speed? 

 
a) Antivirus & Defragmenter b) Firewall & Compiler 
c) Defragmenter & Translator d) Driver & BIOS 

 
Answer: a 

 
Q.14. A CPU performs operations like moving data between memory and registers. 

1. Which type of instruction is this? 

2. Which instruction type changes program flow? 

 
a) Data transfer & Program control b) Data processing & Data transfer 
c) Program control & Data transfer d) Data transfer & Data processing 

 
Answer: a 
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Q.15. A company notices that an employee has copied proprietary software onto a USB drive without 
permission. 

1. Identify the type of computer crime. 
2. Suggest the most appropriate preventive measure. 

 
a) Hacking; Use antivirus software b) Software Piracy; Restrict USB ports and 

implement monitoring 
c) Denial of Service; Install firewall d) Cyberterrorism; Encrypt the data 

Answer: b 

Q.16. A computer is suddenly slow, displaying unknown pop-ups, and files are missing. 

1. Determine the type of malware. 
2. Label it as intrusive or non-intrusive. 

 
a) Trojan Horse; Intrusive b) Worm; Non-intrusive 
c) Spyware; Non-intrusive d) Ransomware; Intrusive 

Answer: a 

Q.17. You need to insert a company logo at the top of every page in a document. 

1. Which feature should be used? 
2. Suggest one way to ensure it does not interfere with text. 

 
a) Footer; Wrap text → In front of text b) Header; Wrap text → Behind text 

c) Watermark; Insert → Shapes d) Page Number; Align → Center 

Answer: b 

Q.18. A student is creating a newsletter with columns and wants the text to flow from one column to another. 

1. Which feature should be used? 
2. Suggest how to adjust column width. 

 

a) Columns (Layout tab); Column Width 
option 

b) Tables (Insert tab); Merge Cells 

c) Text Box (Insert tab); Size options d) SmartArt (Insert tab); Layout options 

Answer: a 
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Q.19. A user wants to calculate the average marks in cells B2 to B12. Which function is used? 

 
a) =COUNT(B2:B12) b) =AVG(B2:B12) 
c) =AVERAGE(B2:B12) d) =MEAN(B2:B12 

 
Answer: c 

 
Q.20. To calculate how many students scored more than 50 in cells C2 to C20, which function is used? 

 
a) =COUNTIF(C2:C20,">50") b) =COUNT(C2:C20,">50") 
c) =IF(C2:C20>50) d) =SUMIF(C2:C20,">50") 

 
Answer: a 

 
Q.21. If you want the first 5 characters of cell E2, which formula is correct? 

 
a) =RIGHT(E2,5) b) =LEFT(E2,5) 
c) =MID(E2,5) d) =SUBSTR(E2,5) 

 
Answer: b 

 
Q.22. Which function will replace "2024" with "2025" in cell H2? 

 
a) =CHANGE(H2,"2024","2025") b) =REPLACE(H2,"2024","2025") 
c) =SUBSTITUTE(H2,"2024","2025") d) =SWAP(H2,"2024","2025") 

 
Answer: c 

 
Q.23. You need to check if cell A1 in Excel is blank, then return “Missing”. Which function works? 

 
a) =IF(ISBLANK(A1),"Missing","OK") b) =IF(A1="",0,1) 
c) =ISERROR(A1) d) =MATCH(A1,"",0) 

 
Answer: a 

 
Q.24. You want to sort a sales report first by region and then by total sales descending. 
 

1. Which feature should you use? 
2. Suggest a step to avoid sorting only one column accidentally. 

 

a) Sort → Custom Sort; Select entire table 
including headers 

c) Conditional Formatting; Highlight top 
values 

b) Filter → Top 10; Apply to first column only 

d) Data Validation; Copy sorted column 

 
Answer: a 
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Q.25. You want to create a chart showing monthly sales trends. 

1. Which feature should you use? 
2. Suggest one chart type suitable for trend analysis. 

 
a) Insert → Charts; Line Chart b) Data → Sort; Pie Chart 
c) Review → Track Changes; Bar Chart d) Insert → Shapes; Scatter Plot 

Answer: a 

 
Q.26. A program executes instructions faster using a smaller, high-speed memory inside the CPU. 

 
1. Which memory is it? 

2. Name its three levels. 

 
a) Cache & L1, L2, L3 b) RAM & SRAM, DRAM, PROM 
c) ROM & EPROM, EEPROM, PROM d) Registers & AC, BR, CR 

 
Answer: a 
 
Q.27. A professional wants to organize emails for different projects. 

1. Which feature of email should they use? 
2. Suggest one method to automate this process. 

 

a) Create folders/labels; Apply rules/filters to 
incoming emails 

b) Delete old emails; Manually sort 

c) Forward emails to others; Use cc d) Archive all emails; Print and file 

Answer: a 

 

Q.28. A user wants to download a software update safely. 

1. What steps ensure safety while downloading? 
2. Suggest how to verify the downloaded file. 

 

a) Download from official website; Check 
digital signature or checksum 
c) Download from unknown link; Trust file 
size 

b) Download from forums; Run without scan 

d) Use torrents; Ignore antivirus 

 
Answer: a 



19  

Q.29. A researcher wants to download multiple PDF papers for offline reading. 

1. Which feature of the browser should they use for batch downloads? 
2. Suggest one safety step before opening PDFs. 

 

a) Use “Save Link As” or Download Manager; 
Scan files with antivirus 

b) Copy text to Word; Open directly 

c) Print from website; Scan later d) Screenshot each page; Save as image 

Answer: a 

Q.30. A student is collaborating on a project using email and cloud storage. 

1. Which approach ensures smooth collaboration? 

2. Suggest one method to track changes and updates effectively. 
 

a) Share files with proper permissions; Use 
version history or activity log 

b) Send attachments via email repeatedly; 
Manually check files 

c) Use personal email only; Print and circulate d) Forward files to everyone; Rely on 
memory 

Answer: a 
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Maximum marks: 100 

 

Section “A” 

Multiple Choice Questions (MCQs) (15 x 1 = 15) 

Attempt 15 MCQs. Each MCQ carries equal marks. 

Practical based Assessments (PBAs) (25 x 1 = 25) 

Attempt 25 MCQs. Each MCQ carries equal marks. 

 

 

Section “B” 

 

 
Short Answer Questions (10 x 3 = 30) 

Attempt any 10 out of 15 questions. Each question carries equal marks. 

 

Section “C” 

Detailed Answer Questions (2 x 15 = 30) 

Attempt any 2 (with sub-parts) out of 3 questions. 

Each question has 2 sub parts of 8 and 7 marks respectively. 

Ziauddin University Examination Board 
Scheme of Assessment 

Computer Science XI 
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S.No Domains Weightage in 
evaluation 

100% 

MCQs 
1 mark 
each 

PBAs 
1 mark 
each 

Short 
Answers 
3 marks 

each 

Detailed 
Answers 
15 marks 

each 

1 Basic Concepts of Information 
Technology 

8 % 3 – 2 – 

2 Information Networks 8 % 2 – 2 1 

3 Data Communications 7 % 2 – 1 1 

4 Applications and Use of 

Computers 

7 % 1 – 2 1 

5 Computer Architecture 5 % 1 – 1 1 

6 Security, Copyright and the 

Law 

7 % 2 – 1 1 

7 Windows Operating System 5 % 2 – 1 0 

8 Word Processing 20 % – 10 2 0 

9 Spreadsheet Software 26% – 15 1 0 

10 Internet Browsing and using 
Email 

8 % 2 – 2 1 

Total # of Questions asked 15 25 15 6 (with 2 
sub parts 
each of 8 

and 7 
marks) 

Total # of Questions to be attempted 15 25 10 2 

Maximum marks attainable 15 
marks 

25 
marks 

30 
marks 

30 
marks 

Ziauddin University Examination Board 

Computer Science XI 

                                                  Table of Specification [TOS] 
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DEFINITIONS OF COGNITIVE LEVELS 
 

Remember 

 

Remembering is the act of retrieving 

knowledge and can be used to produce things 

like definitions or lists. The student must be 

able to recall or recognise information and 

concepts. The teacher must present 

information about a subject to the student, ask 

questions that require the student to recall that 

information and provide written or verbal 

assessment that can be answered by 

remembering the information learnt. 

 

Question Stems 

 

 Can you name all the …? 

 Describe what happens when …? 

 How is (are) …? 

 How would you define …? 

 How would you identify …? 

 How would you outline …? 

 How would you recognise…? 

 List the … in order. 

 What do you remember about …? 

 What does it mean? 

 What happened after? 

 What is (are) …? 

 What is the best one? 

 What would you choose …? 

 When did …? 

 Where is (are) …? 

 Which one …? 

 Who spoke to …? 

 Who was …? 

 Why did …? 

Understand 

 

The next level in the taxonomic structure is 

Understanding, which is defined as the 

construction of meaning and relationships. 

Here the student must understand the main 

idea of material heard, viewed, or read and 

interpret or summarise the ideas in their own 

words. The teacher must ask questions that 

the student can answer in their own words by 

identifying the main idea. 

 

Question Stems 

 

 Can you clarify…? 

 Can you illustrate …? 
 Condense this paragraph. 

 Contrast … 

 Does everyone think in the way that 

… does? 

 Elaborate on … 

 Explain why … 

 Give an example 

 How can you describe...? 

 How would you clarify the meaning...? 

 How would you compare …? 

 How would you differentiate between 

…? 

 How would you describe…? 

 How would you generalise…? 

 How would you identify …? 

 Is it valid that …? 

 Is this the same as …? 

 Outline … 

 Select the best definition... 

 State in your own words... 

 This represents … 
 What are they saying? 

 What can you infer from …? 

 What can you say about …? 

 What could have happened next? 

 What did you observe? 
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 What does this mean? 

 What expectations are there? 

 What information can you infer 

from…? 

 What is the main idea of …? 
 What restrictions would you add? 

 What seems likely? 

 What seems to be …? 

 What would happen if …? 
 What might happen if …? 

 Which are the facts? 
 Which statements support …? 

Apply 

 

The third level in Bloom’s taxonomy, 

Applying, marks a fundamental shift from the 

pre-Bloom’s learning era because it involves 

remembering what has been learnt, having a 

good understanding of the knowledge, and 

applying it to real-world exercises, challenges 

or situations. Students must apply an abstract 

idea in a concrete case to solve a problem or 

relate it to prior experience. The teacher must 

provide opportunities for students to use 

theories and problem-solving techniques in 

new situations and review and check their 

work. Assessment questions should be 

provided that allow students to define and 

solve problems. 

 

Question Stems 

 

 Can you group by characteristics such 

as …? 

 Choose the best statements that apply... 
 Clarify why … 

 Do you know of another instance 

where …? 

 Draw a story map... 

 Explain why a character acted in the 

way that he did... 

 From the information given, can you 
develop a set of instructions about …? 

 How would you develop …? 

 How would you change …? 

 How would you demonstrate…? 

Analyse 

 

Analysing is the cognitive level where 

students can take the knowledge they have 

remembered, understood and applied, then 

delve into that knowledge to make 

associations, discernments or comparisons. 

Students should break down a concept or idea 

into parts and show relationships between 

these parts. Teachers must give students time 

to examine concepts and their requisite 

elements. Students are required to explain 

why they chose a solution. 

 

Question Stems 

 

 Can you distinguish between …? 

 Can you explain what must have 

happened when …? 

 Determine the point of view, bias, 

values, or intent underlying the 

presented material... 

 Discuss the pros and cons of … 
 How can you classify … according to 

…? 

 How can you compare the different 

parts? 

 How can you sort the different 

parts…? 

 How is … connected to …? 

 How is … similar to …? 

 How would you categorise…? 

 How would you explain...? 
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 How would you develop? 

 How would you explain …? 

 How would you modify …? 

 How would you present…? 

 How would you solve … ? 

 Identify the results of … 

 Illustrate the … 

 Judge the effects of … What would 
result …? 

 Predict what would happen if … 

 Tell how much change there would be 
if … 

 Tell what would happen if … 

 What actions would you take to 

perform …? 

 What do you think could have 

happened next? 

 What examples can you find that ? 
 What other way would you choose to 

…? 

 What questions would you ask of …? 

 What was the main idea …? 

 What would the result be if …? 

 Which factors would you change if 

…? 

 Who do you think…? 

 Why does this work? 
 Write a brief outline … 

 Write in your own words … 

 What could the ending have been if ... 
had taken place? 

 State the point of view of … 
 What are some of the problems of …? 

 What assumptions …? 

 What can you infer about…? 

 What can you point out about ? 

 What conclusions …? 

 What do you see as other possible 
outcomes? 

 What does the author assume? 

 What explanation do you have for …? 

 What ideas justify the conclusion? 

 What ideas validate…? 

 What is the analysis of …? 

 What is the function of …? 

 What is the problem with …? 
 What motive is there? 

 What persuasive technique is used? 
 What statement is relevant? 

 What was the turning point? 

 What were some of the motives 
behind …? 

 What’s fact? Opinion? 

 What’s the main idea? 

 What’s the relationship between? 

 Which events could not have 
happened? 

 Why did … changes occur? 
 Why do you think ? 
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 BLOOM'S TAXONOMY WITH EXAMPLES  
If you are a teacher looking for ways to engage your students in learning, this LIST of questions might be interesting for your 

classroom practice. Bloom’s Taxonomy question stems can help elicit higher-order thinking skills and promote critical 

thinking among learners at different taxonomy levels. These question stems can also encourage students to think about their 

knowledge through reflection before answering questions. 

 

ACTION WORDS FOR COGNITIVE LEVELS 

Knowledge 
 

 

 

Understand 
 

 

 

Apply 
 

 

 

Analyze 
 

 

 

Evaluate 
 

 

 

Create 
 

 

 

define explain solve analyze reframe design 

identify describe apply appraise criticize compose 

describe interpret illustrate judge evaluate create 

label paraphrase modify support order plan 

list summarize use compare compare combine 

name classify calculate decide classify formulate 

state compare change discriminate contrast invent 

match differentiate choose recommend distinguish hypothesize 

recognize discuss demonstrate summarize infer substitute 

select distinguish discover assess separate write 

examine extend experiment choose explain compile 

locate predict relate convince select construct 

memorize associate show defend categorize develop 

quote contrast sketch estimate connect generalize 

recall convert complete grade differentiate integrate 

reproduce demonstrate construct measure divide modify 

tabulate estimate dramatize predict order organize 

tell express interpret rank prioritize prepare 

Copy identify manipulate score survey produce 
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discover indicate paint select calculate rearrange 

duplicate infer prepare test conclude rewrite 

enumerate relate teach argue correlate adapt 

listen restate act conclude deduce anticipate 

observe select collect consider devise arrange 

omit translate compute critique diagram assemble 

read ask explain debate dissect choose 

recite cite list distinguish estimate collaborate 

record discover operate editorialize evaluate facilitate 

repeat generalize practice justify experiment imagine 

retell group simulate persuade focus intervene 

visualize illustrate transfer rate illustrate make 

 judge write weigh organize manage 

 observe   outline originate 

 order   plan propose 

 report   question simulate 

 represent   test solve 

 research    support 

 review    test 

 rewrite    validate 

 show     



27  

 

GROUP: PRE-MEDICAL 
 

SUBJECT THEORY PBA TOTAL 

ENGLISH 100 - 100 

URDU NORMAL / 
URDU EASY 

100 - 100 

ISLAMIYAT / 
ETHICS 

50 - 50 

PHYSICS 85 15 100 

CHEMISTRY 85 15 100 

BIOLOGY 85 15 100 

TOTAL 505 45 550 

 

GROUP: PRE-ENGINEERING 
 

SUBJECT THEORY PBA TOTAL 

ENGLISH 100 - 100 

URDU NORMAL / 
URDU EASY 

100 - 100 

ISLAMIYAT / 
ETHICS 

50 - 50 

PHYSICS 85 15 100 

CHEMISTRY 85 15 100 

MATHEMATICS 100 -- 100 

TOTAL 520 30 550 

 

GROUP: GENERAL SCIENCE 
 

SUBJECT THEORY PBA TOTAL 

ENGLISH 100 - 100 

URDU NORMAL / 
URDU EASY 

100 - 100 

ISLAMIYAT / 
ETHICS 

50 - 50 

PHYSICS 85 15 100 

COMPUTER SCIENCE 75 25 100 

MATHEMATICS 100 -- 100 

TOTAL 510 40 550 

HSSC PART I EXAMINATION 

MARKS BREAKUP GRID FOR EXAMINATION 2025 



28  

GROUP: COMMERCE 

 

SUBJECT THEORY PBA TOTAL 

ENGLISH 100 - 100 

URDU NORMAL / 

URDU EASY 

100 - 100 

ISLAMIYAT / 
ETHICS 

50 - 50 

ECONOMICS 75 - 75 

P.O.C 75 - 75 

ACCOUNTING 100 -- 100 

BUSINESS 
MATHEMATICS 

50  50 

TOTAL 550 --- 550 

GROUP: HUMANITIES 

(Any Three Electives) 

 

SUBJECT THEORY PBA TOTAL 

ENGLISH 100 - 100 

URDU NORMAL / 
URDU EASY 

100 - 100 

ISLAMIYAT / 
ETHICS 

50 - 50 

COMPUTER SCIENCE 75 25 100 

ISLAMIC STUDIES 100  100 

MATHEMATICS 100 - 100 

SOCIOLOGY 100 -- 100 

ECONOMICS 100  100 

EDUCATION 100  100 

CIVICS 100  100 

NURSING 85 15 100 

TOTAL 550 --- 550 
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GROUP: MEDICAL TECHNOLOGY 

 

SUBJECT THEORY PBA TOTAL 

ENGLISH 100 - 100 

URDU NORMAL / 

URDU EASY 
100 - 100 

ISLAMIYAT / 
ETHICS 

50 - 50 

MICROBIOLOGY 85 15 100 

HEMATOLOGY & 
BLOOD BANKING 

85 15 100 

ANATOMY & 
PHYSIOLOGY 

85 15 100 

TOTAL 505 45 550 

 

GROUP: PRE-NURSING 

 

SUBJECT THEORY PBA TOTAL 

ENGLISH 100 - 100 

URDU NORMAL / 
URDU EASY 

100 - 100 

ISLAMIYAT / 
ETHICS 

50 - 50 

BIO-CHEMISTRY 85 15 100 

FUNDAMENTALS 
OF NURSING 

85 15 100 

ELEMENTARY ANATOMY 

& MICRO TECHNIQUE 
85 15 100 

TOTAL 505 45 550 

 


